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3D RAILROAD CONCEPT AND DESIGN TUTORIAL

fi

Welcome to the 3D Railroad Concept and Design tutorial. This tutorial, as well
as the other information in this manual, will give you step-by-step instructions
on how to create a sample HO scale layout. Let’s get started.

The layout that we will create will be in HO scale since this is the most popular.
The principles in this tutorial will also apply to other scales. If you are using a
scale other than HO, you may substitute it in the place of HO in this tutorial.
The program is set to HO by default.

GETTING STARTED

The first thing you will notice is that we have a blank layout window labeled
Untitled. The first thing we will do is set up our layout size. Our units of
measurement are set to decimal inches by default. If you wish to change the
units of measurement, you may select another setting and then save it as a
default. Doing this will cause the program to use this setting every time you
open it (sedMetrics & Grid, under Options\Preferences how to change the
default setting in theVhat are all those Menus & ButtonsRapter).

First, select Document Setup, under the File menu. For our sample layout, we
will change the layout dimensions to a width of 300.00 and a height of 175.00.
Since our default units of measurement are in decimal inches, this would make
our layout 300" x 175”. Keep in mind that these numbers will always be in
whatever units of measurement you choose. To change the measurements of
your layout, simply highlight each of the fields and change the numbers
accordingly. For this example, we will leave all of the other settings as they
are. After you have entered the new dimensions, click OK to exit the document
setup. Now press the Caps Lock key on your computer. This will allow the
program to automatically switch to the selector tool after you have used any of
the other tools. Leaving the Caps Lock off will force the program to lock the
tool that you have selected until you select another tool.

USING THE TRACK TOOLS

The first thing we will do is draw a straight piece of track. Click the Straight
Track tool. You will notice that the selector tool turns into a small piece of
straight track with a small cross-hair next to it. Move the track tool into the
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drawing window and place it at the point on the ruler to where it's at 30” down
and 30" across. Holding the left mouse button down, draw a piece of track. It
doesn’t matter at this time how long a piece you draw. You may also hold the
shift key down while drawing a straight piece of track to constrain it

into a perfectly straight angle.
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Fig. 1

Now, click on the piece of track that you just drew with the right mouse button
(you will need to click on one of the rails to select it). Select Properties from
the pop up menu by clicking on it with the left mouse button. This will open
the Track Properties dialog for the straight piece of track that you just drew

(Fig. 2).

The first thing we will do is change the length to 50.00. Now click OK. Select

Er' the Curve Track Tool. Holding the left mouse button down, draw a curved
piece of track. As with the straight piece of track you drew before, it does not
matter how large or small a piece you draw.
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Right click on the curve piece and then select Properties to bring up the Track
Properties dialog (Fig. 3). Change the Radius (1) to 36.00 and then click on the
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small selector dot to the right of the Radius (1) number field. Now change the
Arc Degrees to 180 and then click on the selector dot to the right of the Arc
Degrees number field. You will notice the curve piece in the preview window
change to match the new dimensions. Click OK. Now, left click on the curved
track piece and drag it, holding the button down, so that one of its ends almost
comes into contact with the end of the straight piece. When the pieces are
almost touching, let go of the mouse button and you will see the two pieces

shap together (Fig. 4).
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Now select the straight piece of track that you drew by left clicking on it. Press
CTRL-D to duplicate it. Drag this new straight and snap it onto the other end

of the curve track (Fig. 5).
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CONNECT USING CURVE-STRAIGHT TOOL

To complete our oval, click on the Connect Using Curve-Straight tool. Place
the pointer over the end of the straight piece (point A in figure 5). When the
pointer is in the correct spot, it will turn black. Click and hold down the left
mouse button. You will see a pink square appear at the point where you click
the mouse. While holding the mouse button down, move the pointer to point B
in figure 5. You will see a dotted line from point A to point B. When you move
the pointer to the end of the track at point B, you will see another pink square
appear. This indicates that the connection will be made correctly. Let go of the
mouse button and the program will connect the two pieces of track using
curved track and if necessary, straight pieces. You should now have a complete
oval track (Fig. 6).
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| Tip: At this point, you may want to zoom out so that everything fits on the
a screen better. You can do this by either using the Zoom Out Tool or by pressing
the CTRL and Page Down keys at the same time.

LAYING TURNOUTS

We will now add a turnout and a side spur to our layout. There are three
different methods for creating turnouts. The first one is as follows:

Draw a straight piece of track that measures twelve inches long and snap it to
the right-hand end of the bottom straight piece in Fig. 7. You will see a red line
appear where the two track pieces are joined together. This line indicates the
direction that the turnout is thrown. So we now have a functioning turnout.
The other two methods involve Using Track And Object Libraries and Using
The Track Wizard.

Fig. 7 |

USING TRACK AND OBJECT LIBRARIES

Click on the Get Object From Library button. You will see an Open dialog

(Fig. 8). Scroll to the Track_Atlas.RRL library, select it, and then click Open.
You will now see a library window with all of the Atlas track objects and their
descriptions (Fig. 9). Scroll down and with the left mouse button, select a 9”
Straight Track (Part No. 150). Now click the Add To Plan button. This will
paste the straight piece into the center of your layout. Click on the new straight
piece with the left mouse button and drag it to the end of the turnout you
created so that it snaps together.
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Select the new straight piece and duplicate it four times, using the CTRL-D
function. Snap all of these together so that you end up with a continuous
straight piece coming off of the turnout (Fig 10).
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Click on the Get Object From Library button again. Click on the Open/New
button and select the Objs_Walthers library. Now scroll down until you find the
Vulcan Manufacturing Co. (Part No. 933-3045). Select this item by left-
clicking on it and then click the Add To Plan button. Arrange the building so
that it is towards the end of the spur as shown in figure 11.
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Tip: After selecting a library object, you may click on the Properties button to
see the Group Properties dialog for that object. From here, you can click on the
3D Properties button to see the object rendered in 3D. From here, you can
adjust the elevation, height, and tilt of the object (see the section on editing 3D
Properties for more information). To see what you've done so far in 3D, click
on the 3D button. For help on navigating in the 3D view, see Moving Around

In 3D Window on page 112. When you wish to switch back to the 2D view to
continue working on your layout, click on the 2D button.

CREATING A MOUNTAIN WITH THE TERRAIN TOOL

Now we'll create a custom mountain object with the Terrain Tool. You should
have switched back to the 2D view before proceeding further. First, click on
the Terrain button. Now move the crosshair into the drawing window. With the
terrain tool, we will draw our mountain object. Each time you click the left
mouse button, an anchor point will be dropped.

Fig. 12
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For this example, just draw an oval shape similar to the one shown in figure 12
and place it so that it sits on top of the track. To finish the mountain, double
click with the left mouse button. This will finish the mountain and bring up the
Terrain Properties dialog (Fig. 13). From here, you may select line style and
width, fill, and line and points colors. If you want this object to show up in

your materials report, check the Show in Report box. For this example, we'll
leave everything at its default setting. Click on the Terrain tab at the top of the
dialog to bring up the next set of options (Fig. 14). In this portion of the terrain
editor, we’'ll be able to really start creating our mountain object.
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The first thing we’'ll do is click on the Terrain Editor button. This will take us
to the terrain editor (Fig. 15). With this tool, you will be able to customize your
mountain object to your liking.

Fig. 15 Fig. 16
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The first thing you will notice is that the polygon you drew is presented as a
grid with a red ball (Fig. 15). To create your mountain, click on the red ball

with the left mouse button and hold it down. Now, try moving the mouse up
and down. As you move the ball up and down, the number in the elevation
field will change to the current height of the red ball. You may click on

different points on the grid and change their elevations as well. You may also
use the four arrow buttons to move the red ball around to different points on the
grid. Change several different points of the object to create a mountain similar
to the one shown in figure 16. Don’t worry if it's not exactly like the one

shown. Just try to create an interesting shape at this point. You may click on
the Rotate Left and Rotate Right buttons to spin the object in the editing
window. This way, you can see all sides of your mountain as you build it. If
your mountain object is too large and you need to zoom out, click anywhere in
the white area (but not on the grid object) and then use your up and down arrow
keys to zoom in and out. If you wish to make broader peaks, change the
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number in the Elastic Sensitivity/Distance % to a higher number. This affects
the number of surrounding points that the red ball will grab. Setting the Type
of Elastic Function to Cubical will make more rounded peaks. If you only want
to pull up an individual point, select the Change Selected Point Only option.
Once you are finished creating your mountain, click OK.

Now we will change the texture of your mountain. Click the Browse button
under Terrain Texture. This will bring up the texture selection dialog. Choose
the texture Hill Grass1.bmp and then click the Open button, followed by the
OK button.

Click on the 3D button to take you back to the 3D view of your layout. You
should see the mountain object that you created. But wait a minute..... it's
sitting right on top of your track! We can’t have that. One solution would be to
make a tunnel. To do this, switch back to the 2D view and proceed to the

next step below.

CREATING A TUNNEL

Creating tunnels iBD Railroadis really very simple. First, select the track
piece that is under the mountain object (Fig. 17).

Fig. 17

Right click on this piece and select Properties. Now, in the Track Properties
dialog, set the track type to Tunnel. Click the More button to bring up the More
properties dialog. Here is where you can specify the tunnel height and width,
as well as the texture for the tunnel interior. For now, we’'ll leave the height and
width at their default settings. However, we will change the texture that is used
on the interior tunnel walls. First, click on the Use Texture check box, then
click on the button with the three dots on it to the right of the texture field .

This will bring up the Open Texture dialog. Choose the texture, Stone04.bmp
and click Open, then OK. Click OK again to exit the Track Properties dialog.
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Switch back to the 3D view. Maneuver the view so that you are looking at one
end of the mountain.

Note: You will need to make sure that both ends of the tunnel track extend past
the edges of the mountain object, otherwise, the terrain will not conform to the
track properly.

CONFORMING TERRAIN TO OBJECTS

Now you should see the mountain you created with track coming out of each
side (Fig. 18). Under the Arrange menu, select Conform Terrain to Objects.
You will see a tunnel opening appear on each side of your mountain (Fig. 19).
Creating tunnels with this method also works with curved and graded track so
it's possible to create some really interesting tunnels. If, for any reason, you
need to undo the tunnel, select Restore Terrain from the Arrange menu.

Fig. 19

CREATING GRADES AND ELEVATIONS

The next step in our layout will be to create a grade going up a mountain. The
first thing we will need to do is to create some more track. Back in the 2D view,
select the Straight Track tool and draw a piece of track. After you've done this,
bring up the track’s properties (right click and then Properties). Change the
length to 24”. Select this new piece of track and press CTRL+D to duplicate it.
Make two copies of this piece for a total of three. Snap them to the end of the
straight piece in figure 20. Now, select the curved track (the one closest to
Vulcan Manufacturing) and duplicate it. Snap this to the end of the new
straight pieces you drew (Fig. 21).



| 3D Railroad

39

AW e S L " | Bk taep i Gk +a
5 . n mrrra Rl Asarw

Tr g T e pamey by

Fig- 208 mmmmimummim 'Fig. 21

T T e T [T

Fig. 22

e R LIT ey T T

To finish the second oval, draw a straight piece of track that measures 64.5”
long and snap it to the end of the curve you just placed. Now duplicate this
piece and shap it to the end of the last straight piece you drew. This will
complete the second oval part of the track (Fig. 22). Now we will place a grade
over a section of track. Click on the Chain Track Elevations button. You will
see the selectdool change into a small triangle with a % sign on top of it.
Move the pointer over the first section of track that lies just past the Vulcan
Manufacturing building. You will notice that the pointer will change from
white to black when you move it over the piece of track. When you see it turn
black, click the left mouse button and hold it down. You will see the track
piece you clicked on turn light blue. While holding the mouse button down,
drag it over the next two pieces of track. You will see these turn blue as well.
When the third piece of track turns blue, let go of the mouse button. An
elevations dialog will appear (Fig. 23).
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Click on the lower arrow button. This will activate the Grade % field. Type 3.5
into this field. This will apply a constant 3.5% grade to the 3 straight pieces of
track. So now you have a 3.5% grade on your straight pieces of track but they
are connected to an ungraded curve. No problem. Grab the curved track (the
one on the furthermost right-hand side) ,move it just a little bit, and then snap it
back to the graded straight section. It will now take on an elevation of 2.682,
which is the elevation of the end of the last straight piece of graded track. So
what we have now, is a graded straight section of track which levels off when it
reaches the curve. Now all we have to do is create a descending grade to take
us back to ground level. The first thing we will need to do is use the Cut Track
tool to cut the straight piece of track that creates our turnout (the one that sits
right at the tunnel exit). Click on the Cut Track tool and then cut the straight
piece of track as shown in figure 24 by clicking on the actual track piece in the
appropriate spot.
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Once the track is cut, click on the Chain Track Elevations tool and left click on
the straight piece at the end of the curved track (Fig. 25). Hold the left mouse
button down and move the pointer to the left, over the second straight piece.
Let go of the button and when the Track Elevations dialog comes up, enter the
number 2.682 (The elevation of the curved piece of track) in the Begin box.
The figure in the End box should read, 0.162. Click OK to set this grade. Now
click on the 3D button. You should see your grade as shown in figure 26.
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GRADED TRACK AND MOUNTAINS

Now that we have our graded track laid, let's try putting a mountain over it and
then conform the mountain. This will give a nice effect of the track gradually
going up the mountain.

The first thing we’ll do is to create another mountain object. Click on the
Terrain button and draw a mountain similar to the one shown in figure 27.

Place the same texture on it as you did on the last mountain you drew (Hill
Grassl.bmp). Place it over the track as shown and then select Conform Terrain
to Objects from the Arrange menu. Now go to the 3D view. You should see
that the track has carved out the portion of the mountain that was in its way

(Fig. 28).
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USING THE TRACK WIZARD

o The Track Wizard can be used to create almost any type of complex track piece

7 with ease. For this example, we will construct a right-hand turnout and place it
into our layout. First, click on the Track Wizard button. Once the wizard is

@'l opened, click on the Turnout tab. You will see a turnout with the lengths of
each track piece that make up the turnout.
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The first thing we will do is check the Right option which will change the
orientation of the turnout. Next, change the Entry Length to 1”. This is the
piece of track that is just prior to the point where the other two pieces join
together. Now change Length 1 to 10", Length 2 to 8”, and the Angle to 15.
You'll notice that the turnout in the window changes as you make changes to
the numbers in the editor dialog. Click the Place button to place the new
turnout in the center of your layout. To place this new turnout, we will need to
edit your layout a bit. Using the Cut Track tool, cut the straight piece on the
bottom of the first oval in the middle. Using the zoom tool, zoom up on the
spotwhere you just performed the track surgery. With the selector tool, right
click on the leftmost straight piece and select Properties with the left mouse
button. Set the length of this piece to 7.0. You should now have a gap in the
lower part of your layout (Fig. 30). Drag the turnout you created earlier and
snap it to the end of the left-hand straight piece (Fig. 31).

o — N T o
i [y R 1T nenmm '

Fig. 30 Fig. 31

CONNECT USING SPLINE TOOL

You will notice that there is now a gap at the end of the turnout. One way to
correct this is to use the Connect Using Spline tool. This is an easy way to
close up any gaps you may have in your layout. To use this option, first click
on the Connect Using Spline button and then move the pointer to the end of the
straight track on the turnout. Click and hold down the left mouse button and
draw a line to the end of the track piece that you wish to join up with. As soon
as you start moving the mouse towards the other piece of track, you will see a
pink square appear at the end of the turnout. As you move the mouse closer to
the piece that you wish to join with, you will see a dotted line. When you reach
the other side, you will see a pink square appear at the end of the second track
piece. When you see this second pink square, let go of the mouse button and a
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piece of flex track will be placed into the gap (Fig. 32). You may use this
option anywhere that a piece of flex track would normally work.
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Fig. 32

CREATING PARALLEL TRACK

Now let's add a parallel track section to the new turnout we just placed. Click
on the Parallel Track button. The selector tool will turn into a parallel track
tool. Move this pointer over the section of track that you wish to parallel. For
this demonstration, we’ll select the second piece of straight track after the right-
hand turnout (Fig. 33). Left click anywhere on this straight section of track and
hold the mouse button down. You will see the track turn light blue in color,
much the same as the Chain Track Elevation tool. While continuing to hold the
mouse button down, run the pointer to the right over several more straight
pieces. Stop when you get just past the Vulcan Manufacturing building. At this
point, let up on the mouse button and move the mouse slightly down, away
from the building. You will see a dimension line with two arrows, along with
the separation of the track in inches. Set it as close to 2" as you can and then
click the left mouse button. You will now see a Parallel Track dialog with the
current separation distance of the parallel track that you just created. You may
now type in the exact number that you want.
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The program will measure center to center and place the parallel track on the
layout for you. For this example, set the track separation to exactly 2”. You
will now see your parallel track section appear on your layout.

We will now need to close up the gap in the track between the parallel section
and the turnout. Use the Connect Using Spline tool to accomplish this. When
completed, you should end up with the equivalent of figure 34. The last thing
we need to do to finish the layout is to add a bumper to the parallel track we
just created. Click on the Get Object From Library button and open the
Track_Bumpers library. Select any HO bumper and then click the Add to Plan
button. With the bumper selected, go to the Arrange menu and select Rotate

Right (90). Snap the rotated bumper to the end of the parallel track (Fig. 35) to
complete the sample layout.
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Fig. 35

CREATING ROADS WITH THE TRACK TOOLS

Okay, it's been brought to our attention that Vulcan Manufacturing is in need of

a parking lot and, more importantly, a road so that their employees can get to
work. To do this, we’ll use the track tool.

The first thing we’ll create is the parking lot. Draw a short section of straight
track. Right click on it to bring up the Track Properties and change the
following measurements:

Length: 18.00
Rail Spacing: 14.00
Track Sep: 14.00
Roadbed W: 14.50

H: 0.100
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Elev. Begin: 0.100
Elev. End: 0.100

Show Ties: This should be unchecked. Simply click on the check box to
uncheck it.

Click on the Track Texture button (Fig. 29 b) and then select the texture named
Road03.bmp. Click Open, then click the Roadbed Texture button and select the
texture named Ballast Gray.bmp. Click Open, followed by OK. You now have

a parking lot. You can experiment with these settings and try placing different
textures on this type of track piece for different effects. To create a piece of
road, use the following specifications:

Length: 9.00
Rail Spacing: 2.00
Track Sep.: 2.00
Roadbed W: 2.50
H: 0.100
Elev. Begin: 0.100
Elev. End: 0.100
Show Ties: Unchecked
Track Texture: Road02.bmp

Roadbed Texture:Ballast Gray.bmp

Keep in mind that these numbers are only a guideline. You can experiment

with these to create your own unique road pieces. This method will also work
with curve and spline track. These road pieces can be snapped together just like
track pieces. It is also normal for road pieces to appear in the 2D window as a
hollow line.

RUNNING A TEST TRAIN

We're now ready to run a test train on our layout to make sure that all of our
track connections are valid. Click on the Run Test Train button. The selector
tool will change into a train icon with a small crosshair next to it. Place it close

to a track join and click the left mouse button. This will open the Train

Properties dialog. From here, you can select the train and car objects, the speed
of the train, and the number of cars. You may also select the color of the train

on the 2D layout. Once you have made your choices, click okay to place the
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train. If you want to stop the train, click on the pull-down menu (located to the
right of the Test Train button) and select the Stop Train button.

Tip: When running a test train, you can throw switches by clicking on the red
lines of the turnouts. You will see it move to indicate which direction the
switch is thrown.

NAVIGATING IN THE 3D WORLD

By clicking on the 3D button, we can once again enter our layout from a 3D
perspective. Navigation can be accomplished by using the mouse, keyboard, or
navigation buttons on the top of the 3D screen.

Mouse:

To navigate with the mouse, it is easiest to think of the 3D window as a clock face.
Holding the left mouse button down and moving the pointer toward 12 o’clock

will result in your moving forward. The farther you go toward the top of the
window, the faster you will move in 3D space. Moving the pointer downward
toward 6 o’clock will result in your moving backwards. Right and left movements
are achieved by moving the pointer toward 3 o'clock and 9 o’clock.

Tip: Itis possible to change the altitudeobijects in the 3D window by
clicking on them with the right mouse button and then moving the mouse up
and down. This will not work with track or scenery (mountain) objects.

Keyboard:

To navigate with the keyboard, use the arrow keys (usually located next to the
numbered keypad) to move forward, backward, left and right. To move the
camera up and down, use the Page Up and Page Down keys. To tilt the camera,
hold down the CTRL key in conjunction with the arrow keys. Holding the Shift
key down while using the left and right arrow keys will result in sidestepping
instead of turning in place.

Navigation Buttons:
@+ s i wmE |t b+t T AALs

You may also navigate in the 3D window by using the navigation buttons
located at the top of the screen. These buttons allow you to gain many
different perspectives of your layout. For more information on what the
specific buttons do, see the section on View Menu ltems ikiviit Are All
Those Menus and ButtonsRapter.



